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A tutorial for FIRST people new to 3DSMAX. You’ll use these skills when you started
with your own robot video, but remember that this introduction does not cover all you
need to know!  For instance, use a storyboard to develop your robot’s character or to plan
a memorable story line to help the judges choose your animation over the others.

Let’s go to Earth to the Robot manufacturing plant and create a Robot.
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Introduction

This 3DSMAX 3 Tutorial introduces many basic techniques to create a Robot Vehicle.
These techniques can be used whether you are on Earth or Mars.
The tutorial will take a couple of hours to complete, and will furnish you with techniques
so helpful that your robot video can’t help but win the Autodesk competition!

The following areas are covered
• Drawing in 3D
• Saving your work / file

management
• Creating and Moving
• Animating
• Modifying
• Materials
• Linking

The scene consists of a Sphere cut in
half, a cylinder to act as a neck for
the Sphere, and a Box to act as a body for the robot.

Should you make an unscheduled mistake, use the Undo and Redo options up on the
Main Toolbar.

Right-click to Cancel an operation: Most operations require you to
use the left mouse button (e.g. create, move).  If you right-click while
you still have the left-mouse button pressed down, you cancel the
action.

For instance, if you want to create a Box, but left-click in the wrong
place, you can cancel your  box by right-clicking before you let go of the
left mouse button.

This cancel trick also works when using the mouse to perform a Move,
Rotate, or Scale transform.

One other thing: when the instructions send you to the Modify panel and you do not see
the specified options, make sure you have first selected the object you wish to modify.

☛
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1. Set Backup Options

Make sure you have backup copies of your work.  This will come in handy when you’re
in a tight deadline and something goes wrong.

✑ Customize pulldown
menu > Preferences

 
✒ Click the Files tab

 
✓  Under File Handling,

select Backup on Save
 

✔ In the Auto Backup
section, select Enable.

We discuss this further in
the last section of the
Animating the Robot section.
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1. Create the Robot parts

In these next steps, we create a Sphere, a
Box, and a Cylinder.  Unless otherwise
noted, all clicks use the left mouse button.

✑ In the Create Panel, click on Sphere.
 
 
 
 
 
 

 
 In the Top view, click and drag, then let go to create Sphere01.  Make it about the
size you see in the illustration.  We’ll come back to these objects and you’ll see how
to give them specific sizes.
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 



FIRST  Tutorial – Robot Vehicle

5

✒ 

✓  In the Create panel, click on Box.
 

 The steps to create a box are different from creating a Sphere so hang on!  First
you’ll create the radius of the cylinder, then with a separate mouse click you’ll
specify the height.

 
 
 In the Top view, click and drag to
create the base of the box, then let
up on the mouse button. Now move
the mouse up with no buttons
pressed to create the height. Click
when you’ve given the box some
height. It should look a little thinner
than a deck of cards.

 
 Remember the Undo and right-
click-to-cancel tricks!  This may take several attempts.  Take the time to learn these
steps since you’ll be using them to create your own robot in 3DSMAX.
 
 
 Ready to continue?

 
 

✔ Finally, click on Cylinder .
 

 The steps for creating a cylinder are a little like creating a box. First you create the
size, then the height.

 
 

 In the Top view, click and drag to
create the radius of the cylinder.  Let
go and move your mouse up to
create the height.  Then click to
complete the command.
 
 
 
 

 
✕  

✖  When you’ve finished, click Select object button in the
Main Toolbar.  We’re clicking this so we don’t create any
more cylinders by mistake!
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✗  File > Save.  Name the scene Robot, and click Save.

Review

We’ve learned how to create some simple objects. We’ve also observed that 3D
objects require several views to keep an eye on height, width, and length. For
example, creating the box and the cylinder required that you watch other viewports to
see the height.
The 3DSMAX Reference gives a good explanation of 3D Space, explaining how each
Axis (X, Y, and Z) is used to locate objects you create or move.  Look for “Home
Grid” in the Online Reference Index.
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1. Let’s get Precise! - Modifying the Robot Parts

The parts we’ve created have been placed and sized by eyeball – and vary from user to
user.  Let’s get precise and give specific sizes to the objects, name them, and modify the
Sphere before we start moving things around (on Mars, or Earth).

✑ Click on Cylinder01.

Remember Step 4 above?  We clicked on Select object in preparation for this step.
You knew that, right?

Select the Modify panel, click in the space
where the object is named Cylinder01 to
highlight it, and rename it Neck.

Naming objects:  When you create a scene that has many objects, it’s
easier to work if each object has a descriptive name.  It’s easy to keep
track of three objects, but it’s a good habit to name objects when you
create them. Don’t you agree?

Observe that over blank areas in the Modify panel, the cursor turns into a
hand that can be used for grabbing the Modify panel and sliding it up or
down.  You may need to slide the panel up or down to complete these steps.

Make the following changes in the Parameters
rollout:
• Radius = 10
• Height  = 150
• Segments = 1

The reason we’re changing the Height Segments to 1 is because we don’t need 5, the
default value.  The more segments, the more work for the computer.
If we had plans to bend the cylinder, then we would leave, or perhaps increase, the
height segments. (Also, if we change our mind we can always go back and add
them.)
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✑ Click on Box01.

In the Modify panel, rename it Body.

Make the following changes in the Parameters section for the Box:
• Length = 300
• Width  = 150
• Height = 15

The Body may go off screen.

✑ 

✒ Click on Sphere01.
 

 Rename it Head.
 
 
 
 
 
 The Modifier Stack  allows adjustments other than renaming for the original Sphere.
This Modifier Stack  provides exceptional flexibility for modeling adjustments.
Let’s see how it works.
 

 First off, note the commands Bend, Taper, Twist, etc., which appear in
the Modify panel under the Head.  Now, use your mouse to click in an
empty space back in the viewport.  By doing so Head is no longer
selected and… Whoops! The Bend, etc. commands are no longer
available.  Select the Head again.  The commands return. The nice
thing is that 3DSMAX grays out Modifiers like Extrude or Lathe that are
not appropriate for the selected object.

 
✓  Scroll down the Modify panel to the Parameters rollout and change the Radius of

the Head to 35.
 
 

 
 Change Hemisphere to . 5 and notice what happens
to the Head.
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 Our next step will use the Taper modifier to change the Head into a more Martian-
looking Head. (No, that’s not a Tapir modifier!)
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✔ 

✕  Scroll the Modify panel so you can see the Taper
modifier button.  Click  the Taper button once and
observe the display next to the pushpin icon in the
Modifier Stack.  It now says Taper.
 
 3DSMAX changes the Head’s options so that
they’re relevant for the Taper modifier.  Notice that
the Parameters rollout no longer displays the
Head’s Radius = 35 information.
 
 
 
 
 
 

✖  Let’s change some values in the Parameters rollout:
• Taper Amount = . 5
• Taper Primary Axis = Y.

Depending on the view, the Head will look like this:

That’s all for this section.  Better File > Save now. Congratulations!  (Particularly
the part where you modified the Sphere.)

Review

We want to get into the habit of naming objects that we create.
The Modify panel will only activate when you’ve selected your object.
The Modify stack will display commands appropriate to whatever is displayed in the
Modify stack.

Extra Credit
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If you like, click on the dropdown list next to the
pushpin.  The original Sphere information is still there.
If you select Sphere and make it current, the Parameters
rollout will display the information about the Sphere.
You can change your mind about the size, alter the
Hemisphere value, etc., as you wish. Very nice!

1. Assembling the Robot

We’ve created 3 objects, and resized and named them.  Now we’re going to assemble
them into the robot by moving them into alignment.

✑ 

✒ Zoom Extents All.  Click on the icon located near bottom right corner.
This will cause all 4 viewports to relocate your view so all the objects in
your scene are visible.

 
 
✓  Click Select and Move from the Main Toolbar.

 
 Click on Neck to select it and Move the Neck so it’s centered over the box.

 
 

 Here’s a chance to check out
something that will be very useful
as you Transform (i.e. Move,
Scale, or Rotate) objects.
 
 When you click on an object to
Move it, a bold X / Y icon gets
displayed.  If you position the
cursor on one of the arrows of
this icon, your movement of the
object will be restricted to that axis.  In this Top view picture, the X axis has been
selected, so the Neck can only be moved left or right along the X axis.
 
 Is the Neck precisely centered over the Body?  Let’s make sure with the Align tool.
 

✔ 

✕  Select the Align tool from the Main Toolbar. (Make
sure the Neck is selected when you do this.)
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You may have to slide the Toolbar to the left in order to see the Align
tool.  Use the little hand to grab the bar.  The cursor will turn into the
hand when placed over blank areas of the Toolbar.

Choose the Body to bring up the Align Selection dialog.
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In the dialog, choose:
• 
• X Position
• Y Position
• Center, and

Center

See what happens if
you click the Z
Position also.  After
you see that the center of the Neck aligns with the center of the Body, uncheck it
to get to the correct elevation..

Click OK  to close the dialog.

✑ Click Select and Move from the Main Toolbar.
 
 

 The following step is easier in the
Front viewport.
 
 Click on the Head in the Front
viewport.

 
 Move the Head onto the Neck.
 
 We’ll use the Align tool again for
proper placement.

 
✒ Select the Align tool from the Main Toolbar.

Select the Neck as the Aligning object.

In the Align Selection dialog, make the following selections:
• X Position
• Z Position
• Center, and Center

Click OK to close the dialog.

Notice that we choose the Z Position this time, not the Y Position, because we used
the Front viewport.  In the Front viewport, the X Axis is left and right across the
face of the monitor, the Y Axis is up and down, and the Z Axis moves out of the
monitor towards you and back into the monitor.  When you make a viewport active
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by clicking in it, left and right become the X Axis, and up and down the face of your
monitor become the Y Axis. This is for convenience when modeling.

If this seems confusing to you, remember that Canadian and British users have to
call the Z Axis the “Zed” Axis, so you have it easy!

✑ File > Save.

Review

We were introduced to some keen 3DSMAX tools for moving and precisely aligning
objects.  We also discovered that the X and Y Axes seem to change depending on
your viewport.
And that we’re lucky compared to Canadians and British folks, even without
considering fruitcake.
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1. Animating the Robot

We’ll learn how to move the Robot around, use the Animate button, and Link objects
together.

✑ 

✒ Zoom Extents All.  Click on the icon located near bottom right corner.
 

✓  Find the Time Slider in the Status bar, and Move it (“scrub it”) back and forth.
 

 
 Notice that the total
animation is 100 frames,
and the slider takes you to
the specific frame of the animation.  Even though we’ve moved several objects
around, there is no animation in the viewports.  When you’re preparing your 30
second Robot Animation, you will need to increase the length of your animation to
900 frames. It takes 1 second to play 30 frames on video, so 30 seconds needs 900
frames.
 
 Let’s add some animation.
 

✔ 

✕  Move the Time Slider to Frame 100, all the
way to the right.

 
✖  Click the Animate button to turn it on.

 
 Notice that the Active viewport is now selected
with a red outline.
 

✗  

✘  Click on the Body in the
Perspective view to select it.

 
 Move it back into the distance.
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✙  Turn off the Animate button.
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✑✐ Slide the Time Slider back and forth.

 
 The Body moves back and forth (yay!).  Unfortunately, it leaves behind the Neck
and the Head.  We need to Link everything if we want to convince the competition
judges that we know what we’re doing.
 

✑✑ Move the Time Slider to Frame 0.
 

 The Assembly should line up correctly.
 
 The next steps can be a little confusing, so let’s get introduced to the “Hold” habit.
 
 When you are about to try something that might not work, you first “Hold” your
file.  If you try your experiment and then decide it didn’t work, you “Fetch” your
work from your “Hold.”  You’ll get back to where you were before your
experiment.

 
✑✒ From the Edit  pulldown menu, select Hold.
 

 A special copy of the file has just been saved.
 
✑✓  

✑✔ Click the Select and Link button in the Main Toolbar.
 

 Click to Select the Head, and keep holding down the mouse
button.  Drag the cursor onto the Neck and let go.
 The Head is now linked to the Neck.
 
 Click to Select the Neck again, and drag the cursor onto the Body and let go.
 The Neck is now linked to the Body.
 
 
 Click the Select object button in the Main Toolbar.  This
will end the Linking session.
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 Link cursor:  When you select the first object, the cursor looks
like 2 attached gray boxes. When you drag and select the
second object, the cursor changes to a white box attached to a
gray box.
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✑✕  Move the Time Slider back and forth.

 
 This time the entire assembly should move.  If not, then you might wish to Edit >
Fetch, and repeat Step 10 again.
 

 Extra Credit

 
 
 You may wish to confirm the hierachy of your Linking by clicking
on the Select by Name button in the Main Toolbar, and viewing
the objects in the dialog.
 
 Make sure the “Display Subtree” option at the
bottom of the dialog is selected.  This image shows
the Body as the Parent object, and the Neck and
Head as Children objects.
 When the Parent moves, the Children move too!
 
 What do you think would happen if you tried to
move the Neck?  Could it be moved?  Would the
Head move too?
 
 Close the dialog when through. Later, when you least expect it, we’ll delve into
animating a little further.  We’ll see how each object you create has 2 controllers
automatically assigned to it.  These determine how the object will move.
 

✑✖  File > Save.

Let’s take a moment to understand the files that you have created with all your saves
and Holds.  If we use Windows Explorer to look in the 3DSMAX3\AUTOBACK
folder, we see the following:

• Autobak1.mx
• Autobak2.mx
• Autobak3.mx
• maxhold.mx
• MaxBack.bak

The Autobak1, 2, and 3 files were created by automated saves performed by 3DS
MAX in the background, as a result of our backup settings created at the beginning
of the tutorial.
The maxhold.mx file was created when we did the Edit > Hold command.
The MaxBack.bak gets incremented every time you File > Save. The actual file you
save is in the 3DSMAX\SCENES folder, and has the name we gave it at the
beginning of the tutorial, Robot.max.

 

 



FIRST  Tutorial – Robot Vehicle

20

Review

Moving objects does not create an animation unless the Animate button is on.
One way to move an assembly of objects is to Link them together.  When you move the
Parent of the Linked objects, the Children obediently move along too.
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1. Applying Materials to the Robot

A large component to a good animation is the materials applied to the objects.  Let’s see
how 3DSMAX handles materials.

There are several components to any 3DSMAX material. There is the general appearance,
which could be a plain color, or a bitmap or scanned image. It could have characteristics
of transparency, or could be highly reflective. We’ll keep things simple (just kidding!)
and stick with the sample materials that come with 3DSMAX.

There are a number of shortcuts offered by 3DSMAX to help speed things up, so let’s use
one of them to launch the mighty Material Editor.

✑ 

✒ Click  the letter “m” on the keyboard to open the Material Editor . (If this doesn’t
seem to work, you can use the Tools > Material Editor command.)

 
 The 6 sample spheres
allow you to view the
materials before you
apply them to the objects
in your scene.
 The white rectangle
indicates the current
material, which is this
case is labelled Material
#1.
 
 
 
 
 
 
 
 
 
 
 

✓  Click the Select object icon on the Main Toolbar. (You may have to move the
Material Editor out of the way.)

 
 Select the Head object in the viewport.
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✔ 

✕  Click  the Assign Material to Selection button.
 

 The Head should become the color indicated by the Sample Sphere – Material #1 in
this case.
 
 You might think of a Material as a structure which can have many attributes.  The
Material we applied to the Head so far has a color, and certain specular, reflective,
and opacity values.
 
 Let’s look at applying something more complicated – a Material that incorporates a
bitmap (this could be your scanned image if this were an advanced tutorial).
 

✖  

✗  Click  the Get Material button to launch the Material/Map Browser .
 
✘  Change the settings in the Material/Map Browser  to help select the material.

• Browse From = Mtl Library
• Show = Materials
• Root Only
• View List + Icons
• Metal Brushed (Standard)

Your settings should match the
screen capture.
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✑ Slide the enlarged sample from the upper left corner of the Material/Map Browser
onto the Material Editor  sample slot.

 
 Take a quick look at the Perspective view.  Notice that the Head did not acquire the
new material. There’s some interesting logic behind this, and once you understand it
you will have some powerful knowledge about the Material Editor. Listen:
 
 What happened to Material #1?
 Well, the Head is still assigned Material #1. The Material exists in the scene,
assigned to the Head.  However, in the Material Editor, the sample slot is now
occupied by Metal_Brushed.
 It’s still around, but the sample sphere we were using has been co-opted by the new
material. We want the Head to have the attributes of the new material, so let’s
assign it.
 
 The Material Editor is similar to the artist’s palette.  The color is mixed and created
there, and applied to the painting.  At this point, the color is in two places.
 The 3DSMAX analogy, if you’re following, is that the Material is in the Material
Editor, as well as in the Scene.
 The artist may need to mix new colors on the palette, and since there isn’t room on
the palette might replace the color for a new one.
 What we’ve done in 3DSMAX just now is similar – we’ve got the Material in the
scene, but it’s no longer in the Material Editor.  In Step 7 we assign a new material
to the Head.  This means that Material #1 is no longer in the Material Editor nor in
the scene.  It’s gone.
 3DSMAX does allow you to save materials into Material Libraries, however, so if
you really didn’t want to lose Material #1 we could preserve it.
 
 OK, that’s boring
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✒ 

✓  Click  the Assign Material to Selection button.
 

 The Head should now show a purplish color in the Perspective viewport.  Let’s take
a look at what we’ve got so far.
 

✔ Select Rendering > Render to bring up the Render Scene dialog.
 
 

 Make sure the
Viewport
dropdown at
the bottom of
the screen
shows
Perspective.
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✕  

✖  Click Render.
 

 Not bad!  Here’s what it
looks like so far.
 
 
 
 
 
 
 
 
 
 
 
 
 

 Competition Tip : The image is rather dark – so we’ll have to make
some adjustments for the lighting.  When submitting your animation for
the contest, be aware that the darkness which looks “intriguing” on the
computer monitor will become less distinct when tranferred to video.
This will cause the judges to miss what you’re trying to show. Bad!

 
 Let’s get some materials on the other parts and render to see the results.
 

✗  Close the Virtual Frame Buffer  (the rendered image of your model) to make
room.  You may have to  move other windows out of the way.

 
✘  Click to select the Neck.

 
✙  Scroll through the Material/Map Browser and select Metal_Chrome (Standard).

This should be right below your previous selection.
 

 Drag the enlarged Sample from the upper left of the Material/Map Browser onto a
fresh sample slot of the Material Editor .
 
 
 Click the Material Editor’s Assign Material to Selection button to
assign the Metal_Chrome (Standard) to the Neck.
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✑✐ Click the Body object to select it.
 

 We are going to change to a different Material Library for the Body material.
 

✑✑ 

✑✒ Click  the Open button near the bottom left corner of  the
Material/Map Browser .
 
 
 
 
 
 
 Choose the Ray Traced_01.mat Material Library, and click Open.
 
 Raytracing!  The
bane of quick
rendering times!
Our excursion
will be light-duty
though, so don’t
worry.
 
 
 
 
 
 
 
 
 
 

✑✓  Scroll down the
Material/Map Browser and
choose GlossYellow
(Raytrace).

 
 Drag the enlarged sample
image onto a sample sphere in
the Material Editor.
 
 
 
 
 
 

 

 

 



FIRST  Tutorial – Robot Vehicle

29

 
 

✑✔ 

✑✕  Assign the GlossYellow (Raytrace) Material to the Body.
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 Somewhere along the line our (3DSMAX) windows are going to have to get closed
so we can see the original viewports.  Feel free to close or move any 3DSMAX
windows that are getting in your way.
 
 

✑✖  Select Rendering > Render (or move the dialog so you can access it).
 

 Confirm  that Perspective is the viewport to be rendered.
 
 Click Render.
 
 
 Congratulations!  This
is looking even better!
 
 You should be aware
that raytracing is time-
consuming, and is
something to avoid
when you’re on a
deadline. As you can
see from your rendered
image, extra
calculations must be
performed to reflect the
other objects in your
scene.  But it’s a nice
effect isn’t it?
 
 
 

 Rendering Tip:  It’s always a good idea to save your file before doing
any rendering.  Video drivers, low computer resources, etc., can cause
MAX to crash.  It’s better to crash with the file backed up than not

 
 Whoops!  We’re playing with fire by not saving before rendering.  Let’s do it now.

 
✑✗  File > Save.
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Review

Materials help your models look
real.
The Material Editor and
Material/Map Browser are very
powerful. Consider yourself lucky
to have seen only a portion of their
features.
It’s usually a good idea to Save
your file before Rendering.
The default lighting may be too
dark for your Competition video.
Remember your video is only only
900 frames long.

1. Lighting the Robot
– and One More Thing About Materials

3DSMAX has a default light to illuminate the scene.  We’ll create some lights to make
the scene a little brighter.  This’ll show a little better if we create a surface for the
robot.

✑ 

✒ Zoom Extents All.  Click on the icon located near bottom right corner.
 

 Our next step is a zoom command that will take us far enough away from the robot
that we can create a nice-sized platform for the robot.
 

✓  

✔ Zoom All. Click the icon located near the bottom right corner.  Nothing
happens until we use the mouse in a vertical dragging fashion across the
viewports.  Click and Drag far enough so that the Top view shows the Robot about
the same size as a pea. (see the picture).

 
 This will allow us to have enough space to draw a nice floor, or arena surface for the
robot.
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✕  

✖  In the Create Panel, under Standard Primitives, click Plane.
 

 Before we create the Plane, let’s name it Floor.
 
 
 In the Name and Color rollout, replace the Plane01
name with Floor.
 
 
 
 
 In the Top view, click and drag to
create a rectangle that takes up most of
the Top view. This will be the robot’s
playground.
 
 We need one more visit to the Material
Editor. We could have done this in the
Materials section of this tutorial, but
the Material section was getting too
long.  We thought we’d be able to
sneak this in the lighting section and
you wouldn’t notice.

 
✗  Click  the letter “m” on the keyboard to open the Material Editor .

 
✘  Click  on a new Sample Sphere to select an unused material slot.

 
 Let’s delve into the Material Editor a bit more, and see how to add a checker pattern
to the floor.  We’ll also adjust the size of the checkers too.
 
 
 Move your cursor to a part of
the Material Editor where it
turns into a hand.
 
 Right-click  to bring up the
menu, and choose Maps.
 
 3DSMAX has a lot of useful
right-click functions. This
one helps you manage your
view the Material Editor
options.
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 Now click the button “None” next to the Diffuse Color to bring up the
Material/Map Browser.
 
 
 
 
 
 
 The Material/Map Browser
should be set to Browse from
New.  Choose Checker from the
right-hand list.
 
 OK your selection to return to the
Material Editor.
 
 Make sure the Plane is still
selected in the viewport.
 
 
 
 
 
 
 
 
 Click  the Assign Material to Selection button to give the checker pattern to the
Plane.  Observe the Floor to see whether or not the checker pattern was applied.
 
 
 
 Click the Show Map in Viewport button in order to display the checker pattern.

 
 
 

 Depending on your graphics card settings,
your view of the checker floor may appear
jagged.  Although this will not render the
zigzag appearance, it can be disconcerting to
see it in the viewport.  To fix this, right-
click the label of the viewport (i.e.
“Perspective”) to bring up the menu, and
choose Texture Correction.
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 The Texture Correction setting and the Show Map in Viewport button
are sometimes overlooked when trying to figure out why the bitmap
does not display properly in the viewport.
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 Before we dismiss the Material Editor, let’s adjust the tiling to make the floor
pattern more interesting.
 
 Change the Tiling value
for U and V to 5 and
observe the results.
 
 
 
 Now Let’s get on with the
lighting.
 
 
 
 
 

✙  

✑✐ Go to the Create panel and click the Lights button.
 

 
 Click  the Target Spot light.
 
 
 We will create this spotlight in the Top view, by clicking and dragging. The place
you click first will specify the position
of the light, and the place you drag to
and let up on the mouse button will
specify the target that the light is
pointing at.
 
 Click  at the point corresponding to the
“1” in the picture, and drag the mouse
to the robot (point “2” ) and release the
mouse button  to create the location of
the target.
 
 The top view floor goes black.  What happened? Well, these kinds of things happen
all the time in other areas of life, so why not in 3DSMAX too?  Luckily we can
explain this.
 
  If you look in the Front or Left viewport, you can see we created the light on the
ground, so the top of the floor does not get any light. The lighting that was
automtically provided by 3DSMAX at the beginning is switched off because the
program assumes you want complete control over the lighting.
 
 We need to lift up the light.  Let’s do that in the Front viewport.
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 Click Select and Move.
 
 
 In the Front viewport, click on the light at the edge of the view and hold the mouse
button down.  Drag the mouse up to
place the light about half way up and
release the mouse button.
 
 The Top view begins to look a little
better lit, but still a little dark.  Let’s
crank up the light.
 
 
 
 
 
 

✑✑ Open the Modify panel.  Since the Spotlight is still
selected, the options you see apply to the spotlight.
Scroll or Pan down to the General Parameters.
Here:
• Cast Shadows
• Multiplier = 2.

Before we render to check our work, let’s zoom in on
the robot.

1. Click the letter “h” on the keyboard to bring up the Select by Name dialog.
 

 The keyboard short “h” is one of the most commonly used shortcuts in
3DSMAX.

 
 

 Choose the
Head, Neck , and
Body , and click
Select .
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2. 
3. Click and hold down the Zoom Extents All button to display the flyout.
 

4. Choose the Zoom Extents All Selected button (the one with the white box) to
zoom in on the robot.  
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5. Render the Perspective view.

Not bad.  But there’s
something about the
shadow that would
cause the video
competition judges to
you down.  Notice
how the shadow of the
Neck does not seem
quite attached?  Also,
the shadow is a bit
fuzzy. Let’s correct
this.

The controls we’ll need
to do this are further
down the Modify
panel.

Expand the Shadow Map Params rollout. (You can right-click on the panel, and
select the rollout from the menu instead.)

Change the Bias to 0.  This will connect the shadows towards the body as well as
the base of the Neck.

Set the Size to 1024 and Render the scene again. This does the trick!

The picture at the beginning of the section shows the scene after the light has been
moved a little more overhead, and the Falloff and Hotspot adjustments have been
made to limit the area illuminated.
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✑ 

✒ File > Save.

Review

Lighting requires some experimenting to get the results you’re looking for.  The default
lighting is switched off when you create your own lights.
Even though the section is called lighting, there were some things about Checkers
sneaked in.  It was worth it though, since it brought up some troubleshooting for Texture
Correction and Showing Map in Viewport.
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1. Animating the Neck

Your US FIRST robot will be moving arms or pistons while it is performing in the
competition.  Let’s create some Neck movement for this tutorial. On the way we’ll
learn that objects you create have 2 controls automatically assigned that govern the
type of animation your objects have.

We’ll start by creating setting up a Named Selection Set and a Zoom button for easy
closeups of the Robot. Now that we’ve created a Floor, our zooms need to distinguish
when we need to see the Floor and when we need to close in to the Robot.

✑ Click the letter “h” to bring up the Select by Name dialog, as we did in Step 8 of
the previous section.

 
 Select Body, Head, and Neck, and click Select to close the dialog.
 
 
 
 Locate the Named Selection Set drop
down on the Main Toolbar, and type
the word Robot and hit <enter>.
 
 This will allow you to select the components of the robot whenever you want.  We
will use this to help differentiate when we want to Zoom into the Robot instead of a
Zoom that includes the Floor.  Although the tutorial does not reference the Named
Selection set again, you might wish to do so if you have instructions to “select the
Robot.”
 
 
 Use the 2 Zoom buttons at the bottom of the screen to practice zooming
a couple of times.
 
 

✒ Move the Time Slider to Frame 30.
 

✓  Zoom in on the Robot using the Zoom button for “Selected.”
 
✔ Right-click  in the Left viewport  to activate it.

 
 

 

 

 



FIRST  Tutorial – Robot Vehicle

43

 Type the letter “r ” to change it to the
Right viewport .  The Right view is
better lit.
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✕  Click the Select and Rotate button.
 

 Click the Neck to select it, and hold down the mouse button. (We’re planning to
right-click to cancel our movement.)
 
 
 Move the cursor Up or Down and
observe the movement.  While holding
down the mouse button, click the right
mouse button to cancel the movement.
 
 The Neck should be upright again when
you finish.
 
 Notice that the Neck’s pivot point is
somewhere in the Body, at the bottom of
the Neck.  The fact that the rotation causes the Neck to extend below the Body is
something that we would need to fix for the Robot video, but is something we will
overlook for this tutorial. This will give needed you practice continuing your
animation even when you know something isn’t perfect.
 
 It would be a nice touch if the head did not face down in this position.  Let’s see how
we get the head to stay level while we’re rotating the neck.
 

✖  Select the Head.
 

✗  

✘  Select the Hierarchy tab of the Create panel.
 

 Click Link Info.
 
 Expand the Inherit rollout. We want to tell the Head
not to inherit rotation that might come from rotating the
Neck.
 
 Remove the check next to Rotate X.
 
 
 Why X?  The answer related to the fact that it was
created in the Top view.  Here’s a closeup of the Head’s

axis in the Top view, showing that the X Axis is where we want
the pivoting to not occur.
 
 Let’s test this out.
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✙  Turn on the Animate button.
 
 

✑✐ 

✑✑ Rotate the Neck till the head is near the Body, and release the mouse button.
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
✑✒ Turn off the Animate button.
 
 
 
✑✓  Right-click the Perspective viewport to select it.

 
 

✑✔ Play the Animation.
 

 See how your Robot is not only moving about the Floor, but it’s lifting its head as well!
 
 It would be nice to keep track of the Robot so it doesn’t go off screen.  And it might be
nice – even advanced - to take a tangential trip to TrackView to play with one of the
animation-type controls we mentioned at the beginning of this section.  Of course, after
you gain this knowledge it’s entirely possible that you will dispute the use of the word
“nice.”  But this knowledge may give your competition animation an edge!
 
 First we’ll do what most professional animators do – create a camera and view the
action through its eye.
 
 
✑✕  Stop the Animation.
 
✑✖  Move the Time Slider to Frame 0 before proceeding.
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✑✗  Zoom so that the Top view shows the Robot and the Floor.
 
 

✑✘  Click  the Create panel and choose the Camera
tab.

 
✑✙  Click on the Target button.

 
 We’ll place the camera near our light, pointing
towards the Robot.
 
 
 
 
 

✒✐ In the Top view, click and drag,
starting from the bottom right corner to
position the camera, and dragging to the
Robot and letting go of the mouse
button, to place the target.

 
 Name this Camera Robot Camera,
instead of Camera01.
 

✒✑ Right-click  the Right viewport  to
select it.

 
 Type the letter “c” to change this to the Camera viewport.

 
 The view in the Robot Camera shows a rather small Robot and we’ve put too much
work into our star for that. If you were to put a lot of effort into a Mars lander, and
then lost it because it was too small to see, you’d be disappointed to.
 
 Let’s move the camera in closer and raise the height a bit.  We’ll work in several
viewports to do this till we get something that pleases us.
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✒✒ Use the Zoom controls so that the Top and Front viewports are zoomed far
enough to see the Floor.

 
 Move the Robot Camera up in the Front viewport .
 
 Move the Robot Camera closer to the Robot in the Top viewport.
 
 
 Your camera view might look like
illustration.  (Remember how to
correct the wavy checker pattern?
See Texture Correction at the end of
Step 5 in Lighting the Robot.)
 
 
 
 
 
 
 
 Play the animation while the Robot Camera viewport is active (right-click to
activate the viewport), and when you’re finished playing, Stop, and move the Time
Slider to Frame 0.
 
 We need to have the Camera Target follow the Robot around. We could link the
Target to the Robot.  Or – we could change the object that the Camera looks at.
Let’s have the Robot Camera look at the Neck. This will expose you to a specific
type of Animation controller that you might find useful in your competition video,
the “Look At” controller.
 
 Make sure the Robot Camera is still selected.
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✒✓  Select the Motion panel.

 
 Expand the Look At Parameters rollout.
 
 Click Pick Target, and click on the Neck in the Robot
Camera viewport.
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✒✔ Play the animation again.  This time the Robot Camera follows the robot through its
movement by centering its view on the Neck.

 
 This is what we want.  We’re nearly through!  Congratulations.  The last section
consists of some refinements to the animation.
 

✒✕  File > Save.

Review

We learned a bit about the Linking mechanism.  The Child object inherits its
movements, rotation, and scale from it parent object.  We disengaged the rotation
inheritance from the Neck to the Head.
We’ve learned that 3DSMAX creates objects with Animation Controllers.  The type
of controller determines the kind of movement the object makes. The Look At
controller forces an object (it doesn’t have to be a camera) to always face a specified
target.
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1. Animation and Controllers

We find out more about animation in this section. We introduce a shortcut that allows
us to continue the up and down movement of the Robot Head and Neck. We get re-
introduced to the LookAt controller and learn about the Path Controller as a way of
getting our Robot to move along a path.

We’re getting Advanced training for the price of a beginning tutorial.

1. Make sure you’re at Frame 0, and Zoom Extents your Top view to include the
Floor.

 
 We’re setting up the view in order to draw a path for the Robot to follow.

 
 

2. In the Create panel, click on the Shapes button.
 

 We could choose almost all of the Shape options as a
path, but let’s try out the NGon.
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 Click NGon, and click and drag from
the center of the Floor to create a
Hexagon nearly the size of the Floor, and
release the mouse button.
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 Rename NGon01 to Robot Path.
 
 
 
 
 

3. Click the Select object button on the Main Toolbar.
 
 Select the Body in whatever view is easiest.
 
 

 
 

4. Select the Motion panel.
 

 Open the Assign Controller rollout and click to
highlight  Position.
 
 The Position of the Body is determined by the “Bezier
Position” Controller.  This allows you to move the Body
around with the Select and Move cursor. Since we want
the Robot to follow the path we’ve created with the
NGon we need to change the controller to a Path
Controller.
 
 
 
 
 

5. 
6. Click the Assign Controller icon to bring up the Assign Position Controller.
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 Here you see a list of all the possible ways 3DSMAX can control the Body’s position.
We’ll select Path.
 
 Choose Path, and OK to close the dialog.
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 Scroll down the Motion panel to the Path Parameters section.
 
 
 Click Pick Path, and select the Robot Path in the Top view.
 
 
 
 
 The Robot should move to the “3 o’clock” position of the NGon in the Top view.  It
might be out of the light, however. But let’s play the animation to see what we did.
 

7. 
8. Click Play Animation.

 
 The Robot moves around the path all right, but doesn’t point in the right direction.
There are 2 steps needed to correct this.
 
 Stop the Animation.
 
 

9. In the Path Parameters section of the Motion panel, check:
• Follow
• Axis = Y

Play the animation again – YES!!!  This time the Robot
moves around the path the way we like. While the animation
is playing, right-click in each viewport to activate it. The
motion of the Robot can be viewed in each active viewport.

Stop the animation.

Two more adjustments, and we’re through with this tutorial.
We will get the light to follow the Robot as it moves around, and get the Robot neck
to move up and down while it's going around the path.

1. Select Spot01.
 

 By now you’ve figured out that you can select Spot01 easily by clicking on it in one
of the viewports, or by clicking the letter “h” to bring up the Select by Name dialog.
Use whichever technique you wish.  Isn’t it funny to have a light named after a dog?
 

2. 
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3. Click the Motion panel again, and in the Look At Target
section, click the Pick Target button and choose the Body.
 
 When you play the animation again, the light will follow the
Robot.  This will make our final step easier to see!
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4. Press the “h” key to bring up the Select by Name dialog and choose Neck.
 
 

 Click the Spacebar to lock your selection.
 
 This is a neat trick that will help you keep your Neck selected with your next click.
You can confirm that your selection is locked by the highlighted lock icon at the
bottom of 3DSMAX in the status bar.
 

5. Right-click  on the Neck itself to bring up the menu and choose TrackView Selected.
 

 The TrackView dialog opens up. We’ll use TrackView to get access to the 2nd

controller that is assigned to 3DSMAX objects. The TrackView is used by a large
number of animators who like to manipulate objects with graphs and formulae.  Go
ahead – if you want to be intimidated by this dialog it’s your choice!
 
 Right-click Neck to bring up the menu, and choose Expand All.
 
 Highlight the Transform called Rotation.
 
 You’ll notice that the right half of TrackView shows 2 round “keys” for Rotation.
The one at Frame 0 specifies the vertical angle of the Neck at Frame 0, and the one at
Frame 30 corresponds to the sloped angle we specified at Frame 30.  You can even
right-click on the keys  to bring up a dialog which allows you to control the exact
angle. This is powerful!
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 Click on the Parameter Curve Out-of-Range Types button (conveniently
circled in red in the TrackView display picture above).
 
 This brings up the Parm Curve Out-of-Range Types.
 
 
 Here’s the secret. Objects
created in 3DSMAX are
assigned “Constant.”  This
means that when the
object is animated, say
from Frame 0 to Frame
30, the animation stops
after Frame 30.
 
 Click  on the Ping Pong
diagram to select it (the 2
arrows get selected at the same time) and OK  to close the dialog.
 
 
 Close TrackView by clicking on the X at the top-right corner of the
TrackView window.
 
 Press the Spacebar again to Unlock the selection.
 

6. Play the animation.
 
 The Robot Camera view shows the Robot moving around the Hexagonal path, Neck
moving back and forth, spinning sharply to match each edge of the Hexagonal path.
 You’ve done it!  Congratulations!  You’ve come a long way in this tutorial.
 
 The animation is still far from finished however.  (“What??!”)
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7. Render the animation so you can play it back later.

Rendering > Render brings up the Render Scene dialog.

For Time
Output,
choose
Range.

For Output
Size, choose
320x240.

Click on the
Files button,
and save your
file as
Robot.avi.

Render.

Keep an eye on the Rendering dialog so you have some idea of how long each frame
takes to render.

File > View File to play the Animation you just rendered.  Choose Robot.avi and
watch the results!
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Extra Credit

You notice how the Robot moves abruptly around the path?  Select the Robot Path, and
go to the Modify panel.  Try increasing the Corner Radius to get the Robot to spin
graciously from one straight segment to the next.

More credit to you if you noticed that the Neck movement restarts abruptly when the
animation cycles back to Frame 0.  You know how to correct that? First, select the
Neck. Then look down at the bottom of the screen below the Time Slider and notice the
keyframe dot at Frame 30.  Right-click on the dot and choose “Neck: Rotation.”
Change the value of 30 to something that is evenly divisible into 100 (for example
“25”).

Okay – just one more thing.  You may notice that the rendered animation does not show
the reflection of the Neck as well as you thought. This could be affected by the Spot01
lighting characteristics, like the Muliplier being so strong that the reflection is washed
out.  You can bring up the Material Editor again, and adjust the “Index of Refr” value
and see what happens.

Where are we with the Robot Lander?

This tutorial should give you the incentive to go ahead and create your own design. The
concepts didn’t actually get the robot flying to Mars, but if there were a second tutorial,
you probably would at least get as far as the moon.

Congratulations – we’ve really covered a lot of ground. The 3DSMAX tutorials and
Reference Manuals are much more detailed and are highly regarded, so please don’t
think this tutorial is your only reference. It just happens to jamb a lot of helpful things
into one session.

Good luck with your animation!


